AutoCAD Secrets Exposed!
Jeanne Aarhus – Aarhus Associates, LLC

GD201-4 This session is filled with new time-saving tips and tricks that can be used to increase your AutoCAD productivity immediately. Do you take advantage of new tools or are you still doing things the old way? Attend this session, and you'll learn how to use some of the best and most productivity-enhancing tools that have been introduced in recent upgrades. Leave this session knowing how to dazzle your coworkers back home!

About the Speaker:
Jeanne is known for keeping her training sessions fast-moving and fun. She is a nationally known speaker and expert in CAD and presents seminars and workshops on CAD productivity for managers and users in both corporations and colleges. She has more than 20 years of experience in production drafting, user support, standards coordination, programming, and training in various CAD applications. Jeanne is an independent consultant offering training and implementation services and is certified in several Autodesk and Bentley products. She has been a popular speaker at AU for several years.

jeanne@aarhusassociates.com
So many secrets…so little time!

The topics I selected for this presentation were collected from friends, co-workers, other user groups; and of course the newsgroups.

If you have an idea or a great tip to pass along, I invite you to share your ideas with other users. This only works when we ALL share ideas and concepts. Keep the information flowing….and thanks to all those who helped with this collection of ideas.

About this document:

- Secret available in AutoCAD 2004
- Secret available in AutoCAD 2005
- Secret available in AutoCAD 2006
- Secret available in AutoCAD 2007
- Secret available in AutoCAD 2008

Secret to Expose!

Thanks to everyone who contributed ideas to this session. And remember me if you have a clever way to use ABS or AutoCAD, send me YOUR “secrets”. We all learn through sharing!
Tired of hitting that F1 – HELP by mistake? Use this procedure to alter the F1 key execution command.

**STEP 1:** Key in `CUI` to access the *Customize User Interface* dialog.

**STEP 2:** Expand the *Customizations in All CUI Files* section of the dialog.

**STEP 3:** Expand the *Commands List* section of the dialog.

**STEP 4:** Change *All Commands* to *Custom Commands* and pick the *NEW* button.

**STEP 5:** Change the name of the new command to *F1 CANCEL*.

The command macro is already defined as `^C^C` which will perform a CANCEL command.

**STEP 6:** Expand Keyboard Shortcuts in the *Customizations in All CUI Files* section.

**STEP 7:** Drag-n-Drop the previously made custom command *F1 CANCEL* on top of the *Shortcut Keys*.

**STEP 8:** Expand the *Shortcut Keys* to verify that the F1 CANCEL command has been copied.

**STEP 9:** Select the new F1 CANCEL command in the *Shortcut Keys* section.

**STEP 10:** Access the *Properties* section of the dialog and modify the *Access ➔ Keys* definition to use the F1 shortcut key.

**STEP 11:** Pick the *Browse* button and select the F1 key on your keyboard. Pick *OK* to save the definition.

**STEP 12:** Pick *APPLY* and *OK* to save your changes.

Try out your new F1 key. No more accidental help.

You can still access Online Help using the Help pulldown menu only on purpose from now on!
Tool Palette Control

You can control which tool palette group is displayed using the following commands. Use this command on a pulldown menu or button for easier access by the users in your organization.

**AutoCAD 2006, 2007**

*_TOOLPALETTEPATH_

Switch between tool palette groups (folders) automatically using the following command options:

```
^C^C_*TOOLPALETTEPATH;"path"
```

*Note:* Be sure to use “/” and not “\” when defining the “path” on the macro.

**AutoCAD 2008**

There is a new command for those of you using 2008 that allows you to navigate between palette “groups” easily.

_*TPNAVIGATE_

Use the “group” option to switch between tool palette groups or palettes automatically using the following command options:

- Navigate Groups:   
  `^C^C_*TPNAVIGATE;G;"name"

- Navigate Palettes:  
  `^C^C_*TPNAVIGATE;"name"`
Lost Toolbars

AutoCAD 2007 and Earlier

Use the following key in to find lost toolbars in your interface.

-TOOLBAR

The TOOLBAR command will allow you to “float” the missing toolbar in the middle of your screen; effectively moving it to a visible location.

STEP 1: Key in the command --TOOLBAR to run the command without dialogs.

STEP 2: Enter the toolbar name; in this case the DRAW toolbar.

STEP 3: Key in F to float the toolbar anywhere on your screen.

STEP 4: Key in a new XY pixel position on your screen. 0,0 will float the toolbar in the upper left corner of your screen.

AutoCAD 2008

Use this new option to locate missing toolbars using the new CUI; although the previously mentioned option still works.

STEP 1: Key in CUI to access Customize User Interface

STEP 2: Select the CURRENT workspace

STEP 3: Expand Workspace Contents (on the right side of the dialog)

STEP 4: Expand Toolbars and select the missing toolbar.

STEP 5: Modify the Orientation of this toolbar in the lower pane of the dialog. If you choose “Floating” you must specify the XY pixel location to float it.

STEP 6: Pick APPLY and OK to save these changes

STEP 7: Your missing toolbar should appear as specified.
4 Object Cycle

I am always surprised how many users don’t know this one, or have forgotten about it along the way. No matter what version you are using; working with overlapping objects can be frustrating unless you know this little secret.

AutoCAD 2006 and Earlier

Use the Ctrl key while selecting objects to cycle between overlapping objects. Once you have selected an object you can release the Ctrl key and just <Left-Click> until the object you want is highlighted. Then proceed with your desired command.

AutoCAD 2007-2008

Starting in 2007 the functionality for cycling between objects changed to allow for more “mouse” keyboard shortcuts. Now you can use the Shift+Spacebar to cycle between overlapping objects. Once you have selected the object you can release the Shift key and just continue to hit the Spacebar until the object you want is highlighted. Then proceed with your desired command.
5 Improved Selection

There are many commands available to simplify how you can select objects in the drawing file. I will assume everyone knows about QUICK SELECT; so I thought I would discuss a couple of “other” options.

Available in the Express Tools pulldown menu is the FAST SELECT command.

**STEP 1:** Select Express → Selection Tools → Fast Select

**STEP 2:** Select an object in your drawing file and all objects that “touch” your selected object are automatically selected.

Remember, sometimes it is easier to “de-select” a single object than to select several objects.

Another great selection command is the GET SELECTION command

**STEP 1:** Select Express → Selection Tools → Get Selection

**STEP 2:** Select an object as the source layer object

**STEP 3:** Accept the * if you want to include all objects on this layer in the selection set. You can also specify that you only want lines, blocks, or another object type on the source layer to be included.

**STEP 4:** Now pick the AutoCAD command you want to use to manipulate the selection set; such as MOVE.

**STEP 5:** Key in P for PREVIOUS when asked to select objects and the previous selection set will be recalled.

**STEP 6:** MOVE all objects on the source layer.
6 Control Tray Notifications

Are you tired of that annoying balloon notification for various system messages; such as plotting, unreconciled layers, and reference file changes? If so, try changing this setting.

There is a system variable that controls whether notifications are displayed in the status bar tray. The variable is TRAYNOTIFY and the available options are:

- 0 - Does not display notifications
- 1 - Displays notifications

This is a “registry” setting so you only have to set it once for the change to be recognized from that point forward.

Note: You will still be notified with an exclamation point via an icon change if there is something that has changed.

7 Cycle Viewports

Ever been stuck in a viewport that erroneously was created inside another viewport? How do you activate a “nested” viewport?

Use the CTRL+R to toggle between viewports in paperspace.

Note: You can also <Double-Click> on the viewport object in paperspace to activate that viewport in modelspace using the new MAXIMIZE VIEWPORT command.
New in 2008 is the ability to define layer symbology (color, linetype, weight, etc) on a per viewport basis similar to layer viewport freeze and thaw.

**Use this process to coordinate viewports as shown above.**

**STEP 1:** <Double-Click> in a viewport to activate it and to move the focus of AutoCAD to the viewport.

**STEP 2:** Open the Layer Manager and define the colors, weights, and linetypes using the new VPColor, VPLinetype, and VPWeight columns.

You might need to REGEN the viewport to see the changes.

Notice the “bluish tint” color added to the layer list to help you identify what layer settings has been overridden on a viewport basis.
9 True Distance in Layouts

When working in paperspace it is not necessary to activate the viewport and work in modelspace to perform a measure distance command. AutoCAD will automatically return the “real” distance regardless of what space you are in.

So what do you do if you want the “paper” distance? Be sure to snap to “paper” geometry not “model” geometry when identifying the snap points.

10 Pan a Specific Distance

You can pan using a specific distance using the VIEW PAN command.

**STEP 1:** Select View ➔ Pan ➔ Points

**STEP 2:** Identify the first point to pan from

**STEP 3:** Drag the cursor in the direction of the pan and key in the distance you want to pan. Be sure to use ORTHO or POLAR to control the direction.
There are several system variables that “tweak” the way your mouse works in the AutoCAD view. Try modifying any of these to get better control over your mouse.

**MBUTTONPAN**
Control how the pan (press wheel) command works in a view.

- 0 - Supports the action defined in the customization (CUI) file
- 1 - Supports panning when you hold and drag the button or wheel

**ZOOMFACTOR**
Controls how fast the wheel zooms in and out. The default value is 60.

- 40 – zooms slower per click of the wheel
- 80 – zooms faster per click of the wheel

**AutoCAD 2008 Only**

**ZOOMWHEEL**
Control how the wheel zooms when rolled forward and backward.

- 0 - Moves wheel forward zooms in; moving wheel backward zooms out.
- 1 - Move wheel forward zooms out; moving wheel backward zooms in.

Be careful though…this one can play with your mind! ;}
Open to Named View

Do you use named views to zero in on specific areas and pre-defined layer states? Then you might like this next secret. Use the SELECT INITIAL VIEW option found in the OPEN dialog to open a drawing to a specific named view.

**STEP 1:** Turn on SELECT INITIAL VIEW

**STEP 2:** Open the file and you automatically open to the selected named view and its specific layer and area settings.
13 Annotative Scaling

The new annotative scaling available in the 2008 product line is one of the best feature enhancements to hit the user community in a long time. No longer do we have to jump through layer hoops to control the different plot scales annotation text, symbols and dimensions.

Not only do the new annotative objects automatically scale; but they are smart enough to teach themselves along the way.

Use the **Automatically Add Scales** option to add scales dynamically as needed.

| Annotation Scale: 1/2" = 1'-0" |

Use **Annotation Visibility** to display one or all of the scales defined as needed.

| Annotation Scale: 1/2" = 1'-0" |

Use the **Annotation Scales** to set the view to a specific scale and adjust annotation automatically.

| Annotation Scale: 1/2" = 1'-0" |

What more can we ask for?

14 Streamline MTEXT

Do you still use DTEXT more than MTEXT? If you could streamline your MTEXT command would that help you make the transition? Try this out!

Create a custom MTEXT button using the following syntax:

```
^C^C_MTEXT;\W;0;
```

Is that better?

If you still want MTEXT to work like DTEXT try modifying this setting:

```
MTEXTFIXED=1
```

If I call this secret Multi-line DTEXT will you use it now?
New in the 2008 is the addition of multi-column MTEXT. This improves the overall appearance of large amounts of notes needed in the drawing file and the pagination is dynamic.

**STEP 1:** <Double-Click> on an existing text object to edit

**STEP 2:** <Right-Click> in the MTEXT dialog to access the Dynamic Columns command

**STEP 3:** Select Auto Height

**STEP 4:** Pick OK to save the changes.

**STEP 5:** Dynamically modify the column width using the new grip provided.
New in 2008 are the new Multi-Leader commands that automatically provide tools and functionality for creating multiple leaders. Much better than what we had to do in prior versions.

Open the Multi-Leader toolbar to try out these new tools.

First, you need to define a Multi-Leader style.

**STEP 1:** Select the **Multi-Leader Style** button

**STEP 2:** Define a **NOTE** leader style using the following settings
STEP 3: Use the **ADD LEADER** command to add additional leaders to the note.

STEP 4: Use the **REMOVE LEADER** command to remove leaders from a leader.

STEP 5: Use **ALIGN LEADERS** to align existing leaders for improved appearance.

STEP 6: You can use **MTEXT** or blocks in your new leaders.

STEP 7: Use **COLLECT LEADERS** to join all similar leaders together.
17 Dimension Priority

Using 2008 you can now define extension line priorities for those “overlapping” extension lines without exploding the dimension; or using wipeouts.

Use the new DIMENSION BREAK command to select the extension line you wish to “break” at the overlapping location. Don’t worry, it doesn’t really break the dimension; just fakes it out!

**STEP 1:** Open the DIMENSION toolbar and select the DIMENSION BREAK command.

**STEP 2:** Select the extension line you want to “break”
Layer Lock Fading

Using 2008 provides you with additional display controls over locked layers. Layer Fading of the locked layers improves the visual representation of layers you cannot modify.

LAYLOCKFADECTL

0 - Locked layers are not dimmed.

>0 - When the value is positive, controls the percent dimming up to 90 percent.

<0 - When the value is negative, locked layers are not dimmed, but the value is saved for switching to that value by changing the sign.

The above display has locked layers with 70 percent fading.
Print Layer List

There are two primary options for printing a layer list from within AutoCAD.

The first option has been available for a while now. You must access the LAYER command from the command line not the Layer Manager dialog.

**STEP 1:** Key in –LAYER to run the command without a dialog.

**STEP 2:** Key in ? to query all layers in the file.

**STEP 3:** Key in * to list out all layers in the command line.

**STEP 4:** Highlight the layer list from within the command line window and copy them to the clipboard using CTRL+C.

```
Layer name | State | Color   | Linetype  | Lineweight
------------|-------|---------|-----------|------------
"0"         | on    | -P 7 (white) | "Continuous" | Default
"9F"        | on    | -P 15  | "Continuous" | Default
"1F1M"      | on    | -P 15  | "Continuous" | Default
"2F"        | on    | -P 7 (white) | "Continuous" | Default
"3F"        | on    | -P 7 (white) | "Continuous" | Default
"Border"    | on    | -P 5 (blue) | "Continuous" | Default
"CAX"       | on    | -P 32  | "Continuous" | Default
"CAIX"      | on    | -P 32  | "Continuous" | Default
"DEPOINTS"  | off   | 7 (white) | "Continuous" | Default
"Dimensions (CITAS)" | on | -P 212 | "Solid" | Default
"Dimensions for stairway" | on | -P 212 | "Continuous" | Default
"Doors"     | on    | -P 142 | "Continuous" | Default
"Equipment" | on    | -P 92  | "Continuous" | Default
"ESTR"      | on    | -P 142 | "Continuous" | Default
"FAC"       | on    | -P 142 | "Continuous" | Default
"FACH"      | on    | -P 142 | "Continuous" | Default
"Hatch"     | on    | -P 15  | "Continuous" | Default
"Interior Walls" | on | -P 7 (white) | "Continuous" | 0.300 mm
"Partitions" | on    | -P 7 (white) | "Continuous" | Default
"PA%H"      | on    | 8      | "Continuous" | Default
"Pillars"   | on    | -P 30  | "Continuous" | Default
"Sections Corte" | on | -P 9  | "Solid" | Default
"Text 0"     | on    | -P 212 | "Continuous" | Default
"Title Block" | on | -P 212 | "Continuous" | Default
"VAD"       | on    | -P 132 | "Continuous" | Default
"Viewports" | on    | 7 (white) | "Solid" | Default
"Xrefs"     | on    | -P 7 (white) | "Continuous" | Default

Current layer: "0"
```
The second option was a “secret” I found out from a participant at AU last year.

Try this out…pretty neat, eh?

**STEP 1:** Open the *Layer Manager* dialog

**STEP 2:** *<Right-Click>* and select all layers in the dialog

**STEP 3:** Issue a *CTRL+C* to copy the layer list to the windows clipboard. It doesn’t appear to do anything…but it does copy the information.

**STEP 4:** Open a text file, or better yet open an Excel spreadsheet and paste the information.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>On</th>
<th>Freeze</th>
<th>Lock</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
<th>Plot Style</th>
<th>Plot</th>
<th>New VP Freeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>white</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>Normal</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>3</td>
<td>1P</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>10</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_1P</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>4</td>
<td>1FIN</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>10</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_1FIN</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>5</td>
<td>3P</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>white</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_3P</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>6</td>
<td>3FIN</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>white</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_3FIN</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>7</td>
<td>Border</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>blue</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>LAYOUT_Border</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>8</td>
<td>CAI</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>52</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_CAII</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>9</td>
<td>CAIX</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>52</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_CAIX</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>10</td>
<td>DEPOINTS</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>white</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>Normal</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>11</td>
<td>Dimensions (COTAS)</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>212</td>
<td>Solid</td>
<td>ByLineWeightDefault</td>
<td>ARCH_Dimensions (COTAS)</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>12</td>
<td>Dimensions for stairway</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>212</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>ARCH_Dimensions for stairway</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>13</td>
<td>Doors</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>142</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_Doors</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>14</td>
<td>Equipment</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>92</td>
<td>Default</td>
<td>ByLineWeightDefault</td>
<td>PLAN_Equipment</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>15</td>
<td>ESTR</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>92</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_ESTR</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>16</td>
<td>FAC</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>142</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_FAC</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>17</td>
<td>Hatch</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>15</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_Hatch</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>18</td>
<td>Interior Walls</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>16</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_InteriorWalls</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>19</td>
<td>Partitions</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>16</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_Partitions</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>20</td>
<td>PAVM</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>0</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>ARCH_PAVM</td>
<td>FALSE</td>
<td>FALSE</td>
</tr>
<tr>
<td>21</td>
<td>Piles</td>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>30</td>
<td>Continuous</td>
<td>ByLineWeightDefault</td>
<td>PLAN_Piles</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

What you didn’t know that was possible? Don’t feel bad…neither did I…after all…it’s a secret!
20 On-the-Fly Block Basepoints

You can modify the block insertion base point using the BASEPOINT option during insertion.

**STEP 1:** Run the INSERT command.

**STEP 2:** Key in B to define a new BASEPOINT on the block.

**STEP 3:** Snap to the new basepoint and place the block.

21 Cycle Basepoints

You can provide alternate block insertion points for use with the INSERT command using point parameter objects in a dynamic block definition.

**STEP 1:** Select the block you want to have alternate insertion points

**STEP 2:** <Right-Click> and select the BLOCK EDITOR command

**STEP 3:** Place POINT parameter at the alternate insertion point locations.

**STEP 4:** For once, you can ignore those “exclamation points” that normally indicate you haven’t completed the parameter definition.

**STEP 5:** Close the Block Editor and SAVE the changes to the block.

**STEP 6:** Insert the block again and use the CTRL key to toggle between the new “alternate” insertion points.
Quick Fillet

Want to use the FILLET command quicker than before? Did you know that you can use a crossing to select objects simultaneously?

**STEP 1:** Select the **FILLET** command

**STEP 2:** When asked to select objects key in **C** for **CROSSING**

**STEP 3:** Use a crossing window to select the objects.

Hatch Defaults

Do you always have to change the default hatch pattern because ANSI31 is not the most common hatch for your work? Me too! I would prefer to have SOLID my default hatch.

Here is how you can modify your “default” hatch pattern for future hatching commands.

Use the system variable **HPNAME** and set it to the pattern of your choice

**HPNAME = SOLID**

Sorry, but this setting isn’t saved anywhere so when you close AutoCAD it reverts back to ANSI31.

So how can you save this change permanently? Try using the ACADDOC.LSP file. You can create and place the ACADDOC.LSP in any support path directory and it will be loaded automatically each time a drawing is accessed.

Use the file ACADDOC.LSP to save these “favorite settings” every time you run AutoCAD.

```
(setvar "HPNAME" "SOLID")
```

*Note: Use the . character to reset the pattern back to the default hatch.*
Now that the COPY command is automatically multiple; do you wish for other “multiple” commands? What about the LINE command; or the FILLET command?

The only problem with the MULTIPLE command is that you have to hit ESC to stop it; and it won’t work with commands that use a dialog box.

Multiple LINE

STEP 1: Key in MULTIPLE

STEP 2: Key in LINE for the command to repeat

STEP 3: Draw several lines without stopping the command.

STEP 4: Issue an ESC to end the line command.

Multiple FILLET

STEP 1: Key in MULTIPLE

STEP 2: Key in FILLET for the command to repeat

STEP 3: Clean up several line intersections using the multiple fillet

STEP 4: Issue an ESC to end the fillet command.
I have always been an advocate for “AutoCAD for the Lazy User”; after all who has time to fiddle with commands these days right? Here is a “secret” I love; hope you do to.

This command will allow you to open automatically open Windows Explorer to the project folder of the currently open drawing file. No more navigating between project folders in Windows and AutoCAD. Hurray!

Place this command on a button or pulldown menu and try it out.

```
(command "start" (strcat "explorer " (getvar "dwgprefix")))
```

**STEP 1:** Open the CUI dialog

**STEP 2:** Create a new command using the syntax listed above

**STEP 3:** Create a new toolbar and add the new command to the toolbar.

**STEP 4:** Save your CUI changes and try out the new command.

So what does all this mean?

```
(command "start") tells AutoCAD to shell out and start another program.

(strcat "explorer ") tells the operating system to start Windows Explorer

(getvar "dwgprefix")) tells explorer to browse to the current drawings prefix, which happens to be the folder it is located in.
```

Thanks Todd!
No More LTSCALE?

Tired of setting LTSCALE yet? Me too; especially when moving between modelspace and paperspace right? Here is an enhancement in 2008 that I never thought we would see….at last….no more LTSCALE “switching”.

A new system variable MSLTSCALE scales linetypes in modelspace using the new annotative scale settings.

**MSLTSCALE**

0 - Linetypes displayed on the Model tab are not scaled by the annotation scale
1 - Linetypes displayed on the Model tab are scaled by the annotation scale

Using this new variable you can set your LTSCALE to your company standard; usually .5 or .375. After that, MSLTSCALE will manage the line scales automatically and YOU NEVER HAVE TO SET IT AGAIN!

Lengthen

The LENGTHEN command is a great command that somehow has gotten lost in the upgrade shuffle and has become “hidden” for many users.

I often use the LENGTHEN command to list out the length of an object with messing with a MEASURE command or even the old LIST command.

LENGTHEN can be found at Modify → Lengthen or as a key in at the command line.

**STEP 1:** Run the LENGTHEN command and select an object to display its length.

Use the TOTAL option to modify an existing object to a desired length without having to measure and stretch it. LENGTHEN will shorten or lengthen as needed.

*Note: You can also use the Length setting in the Properties dialog*
Use the system variable PEDITACCEPT to simplify your polyline editing. After all, have you ever answered NO to the PEDIT question stating that the object you selected is not a polyline – would you like to convert it to one? Me neither…what a silly question! To NEVER see this question again change this system variable.

PEDITACCEPT

- 0 - the prompt is displayed
- 1 - the prompt is suppressed

Use the multiple PEDIT option or the MPEDIT command to cleanup some of that “messy” linework.

**STEP 1:** Key in **MPEDIT**

**STEP 2:** Select the linework to cleanup

**STEP 3:** Key in **J** to **JOIN** linework after cleanup

**STEP 4:** Enter and appropriate “fuzz factor” to clean up gaps and overlaps as needed
Use the SOLVIEW command to create orthogonal views of a 3D solid in paperspace. This command also creates the layers needed for the following command SOLDRAW which will automatically draw the flat orthogonal views of the 3D solid.

**STEP 1:** Select the layout for orthogonal views

**STEP 2:** Key in the **SOLVIEW** command

**STEP 3:** Key in **U** for the **UCS** option

**STEP 4:** Key in **W** for the **WORLD** view of the 3D solid

**STEP 5:** Select the location for the center of the **TOP** view

**STEP 6:** Press **ENTER** when viewport is in correct location

**STEP 7:** Pick two points to define the viewport “extents” for the **TOP** view.

**STEP 8:** Key in **O** for the **ORTHOGONAL** option to generate the **FRONT** view from the **TOP** view.

Snap to the bottom midpoint of the **TOP** viewport.

**STEP 9:** Select the location for the center of the **FRONT** view

**STEP 10:** Press **ENTER** when viewport is in correct location

**STEP 11:** Pick two points to define the viewport “extents” for the **FRONT** view.

**STEP 12:** Key in **O** for the **ORTHOGONAL** option to generate the **SIDE** view from the **FRONT** view.

Snap to the right midpoint of the **FRONT** view.

**STEP 13:** Select the location for the center of the **SIDE** view

**STEP 14:** Press **ENTER** when viewport is in correct location

**STEP 15:** Pick two points to define the viewport “extents” for the **SIDE** view.

Note: Make sure that the template file has the **HIDDEN** linetype embedded so that **SOLVIEW** can create the layers with associated linetypes correctly.
Use the SOLDRAW command to generate the 2D linework views of the 3D solid.

**STEP 1:** Key in the **SOLDRAW** command

**STEP 2:** Select the viewports created using the **SOLVIEW** command.

Access modelspace and note that the flat linework was drawn on the appropriate layers.
32 Generate 3D Solid from 2D Linework

You can also generate a 3D solid from the existing flat linework.

**STEP 1:** Generate flat polylines that define the “shape” for TOP, FRONT and SIDE views of the 3D solid.

**STEP 2:** Use the **EXTRUDE** command to extrude the flat polylines through all other parts as needed.

**STEP 3:** Use the **INTERSECT** command to keep only the intersecting portion of the 3 extrusions created.
You can use the new XCLIP command to CLIP or MASK a portion of the reference file.

### CLIP

**STEP 1:** Select the reference file to clip

**STEP 2:** `<Right-Click>` and select the **XREF CLIP** command

**STEP 3:** Key in **R** for the **RECTANGULAR** clipping option

### MASK

**STEP 1:** Select the reference file to mask

**STEP 2:** `<Right-Click>` and select the **XREF CLIP** command

**STEP 3:** Key in **I** for the **INVERT CLIP** option

**STEP 4:** Key in **R** for the **RECTANGULAR** clipping option

*Note:* You cannot do both a CLIP and a MASK on the same reference file. Maybe this should be a wish list item eh?
Quick Detach

Once I had these shortcuts to simplify my reference file manipulations I wanted to have a quick XREF DETACH option. However, for some reason there is not an XREF DETACH command in 2008. A co-worker pointed me to this lisp routine that allows me to detach a reference file by selection.

Great! Problem fixed…I made a custom command and placed it on the appropriate <Right-Click> menu.

STEP 1: Start the CUI command

STEP 2: Create a custom command XREF DETACH

STEP 3: Assign the following macro to the new XREF DETACH command.

\[^C^C\_xrdet;\]

STEP 4: Expand the Shortcut menus \(\rightarrow\) Xref Object Menu

STEP 5: Drag-n-Drop the command XREF DETACH onto the Xref Object Menu

Note: Xref OBJECT Menu applies to a single selected xref.
      Xref OBJECTS Menu applies to multiple selected xrefs.

AutoLoad the XRDET Lisp routine

STEP 1: Start the CUI command

STEP 2: Expand the LISP FILES section

STEP 3: <Right-Click> and select the XRDET.LSP file
35 Bind YOUR Way

Use the system variable BINDTYPE to specify your preferred method for binding references files. If you are tired of getting those 0$0 layers; switch your preference to INSERT and the problem goes away.

BINDTYPE

0 - Traditional binding behavior (layer "xref1|one" becomes "xref$0$one")
1 - Insert-like behavior (layer "xref1|one" becomes "one")

Places You Need to Know

Mike Massey  www.knowingwhatyoudontknow.blogspot.com
Richard Binning “Beside the Cursor”  www.integr-8.com/besidethecursor
Erhan Toker  www.dailyautocad.com
Todd Shackelford “The Lazy Drafter”  lazydrafter.blogspot.com
AUGI “Autodesk User Group International”  www.augi.com
That's probably more than I have time for….but hopefully not more that you wanted to know!

Thank you for your time

*Hope you enjoyed the session!*

Looking for customized Training and Standards consulting using your company standards and procedures?
Call for affordable and flexible rates and schedules.

Contact:

**åarhus ASSOCIATES, LLC**
12005 Quail Drive
Bellevue, NE  68123-1175
[www.aarhusassociates.com](http://www.aarhusassociates.com)

Jeanne Aarhus
(402) 408-9696
jeanne@aarhusassociates.com